
MAXIMIZING PROGRAM MANAGER AND 
WINDOWS SCREEN ELEMENTS
CONVENTIONAL WISDOM HOLDS THAT THE GREAT BENEFIT OF WINDOWS IS graphics.
Certainly, Windows is a superb graphics computing environment-a much friendlier, 
more flexible way to handle computing chores than DOS. But there have been other 
graphics environments over the years, and none has taken off like Windows.

What really sets Windows apart is its customizability. Great lip service has 
been paid over the last decade to how valuable PCs are as competitive weapons. But 
how much advantage could genuinely be attained when all PCs ran the same 
processor, the same DOS, and the same applications running in precisely the same 
manner? Nada.

Windows brings the personal back to PC. Because virtually every aspect of 
Windows can be altered to suit the user's taste-from colors and screen display to 
intricate arrangements of applications-this is the first environment that actually 
makes it possible for one PC to run smarter than another. A sophisticated user does 
not have to become a professional programmer to make Windows utterly unique.

In this chapter, we'll explore the myriad ways you can tinker with the already 
excellent standard approaches Windows offers-so that you can set off on the exciting 
journey of making your PC absolutely your own personal property.

Most Windows users will be content with the Windows shell, Program Manager,
which is the focus of most of this chapter. However, we should note that third-party 
applications can serve you just as well or better. If you aren't satisfied with Program 
Manager, consider alternatives such as the Norton Desktop, hDC's Power Launcher, 
the uniquely object-oriented WinTools (it's virtually menu-free), or New Wave, from 
Hewlett-Packard. We examine several of these alternatives in Part 2.

Building and Managing Program Groups
The key to understanding the Program Manager, and the place where Windows most 
stands apart from all other graphic environments (including the Macintosh) is in its 
program groups. A program group is an array of icons within a single on-screen 
window. These icons represent applications. Windows provides several program 
groups upon startup, including the Main and Startup groups. You can create your own
program groups as well.

The icons in a Windows program group are defined as program items: These 
are Windows-defined objects that contain enough information to tell Windows how to 
find and launch an application and, optionally, load a particular file. One program 
item might be labeled Excel and another, with an identical icon, might be labeled 
First-Quarter Sales. Rather than booting Excel and then calling the file, you can click 
on the First-Quarter Sales icon to launch the application and load the file in one step.

What's most unique about Windows program groups and the items they 
contain is that they are not directly tied to directories and other aspects of the 
traditional file system. DOS applications and Windows applications can reside side by 
side in a program group. A single application can appear in as many program groups 
as you wish, even if it resides just once on the hard drive.

Because of this flexibility, you can organize Windows, through the program 
groups, to reflect any work style you choose. You can group applications by time of 
day, operating system, function, or letter of the alphabet. And then, you can arrange 
your display screen to emphasize what you wish and to hide what you use less often.

Program groups provide a new ultimate in user control of the display of 
application programs.



Shortcuts for Program Group Basics
We won't spend much time in this section on instruction in the absolute basics of 
creating program groups and manipulating program group windows here. Windows 
documentation and on-line help handles that task admirably. Our principal focus is on
clever ways experienced users have found of speeding tasks. These first tips deal 
with improving program groups beyond the basics.

Start a Program Group The only way to start a new program group is from the 
Program Manager's File menu. Click on New, and a dialog box with two option buttons
will appear: Program Group and Program Item. Click on Program Group, and then click
on OK. A dialog box will appear, asking for two pieces of information. The Description 
is the name you'll use to refer to the new group from within Windows-the name that 
the Program Manager will display whenever the group or its icon is on the screen. The
Group File, which is the file where information about the group is stored, can be any 
DOS filename you want; Windows defaults to a .GRP filename extension and 
automatically assigns it a DOS filename based on your description if you fail to select 
an alternative. Click on OK and you'll see a blank window titled with your program 
group's name.

Add a Program Item to a Group Once you've created a group, you can fill it 
with program items in any one of three ways: You can use the Program Manager's File
menu, or you can copy or move the program's icon from another program group by 
dragging it with the mouse.

To use the File menu, select New, make sure Program Item is checked, and 
click on OK. The Program Item Properties dialog box that comes up at this point 
differs slightly from the one presented when you create a new program group. The 
Description becomes Windows' name for the program, while the Command Line is the
name of the executable file, including extension and subdirectory, of the application 
you're putting into the group. If you're not sure of your program's exact name or 
location, click on the Browse button. Up pops a window containing two list boxes, one
for files and one for directories. Use them to find the filename you seek; then double-
click on it. Program Manager will insert the path and filename in the Command Line 
box. The program you install need not be a Windows program. Program Manager can 
launch standard DOS applications as well, which should help to ease your transition 
to the Windows environment.

When you want to move or copy a program item from one group to another, 
start by opening both group windows. If the windows overlap on the screen, use the 
Tile command in Program Manager's Window menu to place them side by side. To 
move the program item, drag its icon from one window to the other by placing the 
icon on it, then holding down the left mouse button while moving the mouse. If you 
want to copy it instead, drag the icon while holding down the Ctrl key. You can also 
copy a program item to the same group if you want to have more than one copy in 
that group. You might do this, for instance, if you want to load spreadsheets with 
different documents upon start-up for different kinds of budgeting.

Delete a Program Item from a Group To delete a program item from a 
group, click on the program item's icon and then either choose Delete from the 
Program Manager's File menu or press the Delete key on your keyboard. The same 
technique works for a program group, but you must "iconize" the group first, by 
clicking on the Minimize button in the window's upper-right corner. (This isn't 
necessary if the program group is empty.)

Create Program Groups for Specific Tasks Don't confine yourself to 
Windows' default program groups and icons. Set up new groups that fit the way you 



work. For example, if you start a new project that will be taking up most of your time, 
you can create a program group just for that task. In the group, place icons 
representing the applications that you'll be using. If you are working on a 
presentation for a new client, your group might be named "Acme Proposal." The 
custom icons you might have in the group would be your presentation program, 
Persuasion, with the data file of the current presentation you are working on; your 
word processor, Word for Windows, with the draft proposal loaded; your spreadsheet, 
Lotus 1-2-3 for Windows, with the most recent sales figures; and the Notepad text 
editor, with a to-do list (see Figure 5.1). Once you've copied the original program 
icons into the new group, edit them to use custom icons and load the actual files 
you'll be using for the project.

To do this, select the icon and choose File, Properties. You can change the 
name of the application to reflect what it will actually be used for. For example, you 
could rename the Word for Windows icon Draft-Winword and the Lotus 1-2-3 icon The 
Numbers-Lotus 123/W. To change the icons, click on Properties in the File menu. Then 
choose Change Icon, Browse, select an icon source file, such as MORICONS.DLL, and 
click on OK. You'll be presented with a collection of icons to choose from. (See "Modify
Program Item Properties" and "Icon-ography and Creative Dragging" later in this 
chapter for more on icon changing.) You'll also want to edit the application's 
command line to load the specific files you'll be using. To do so, specify the name of 
the file and its path on the command line. For example, to load the Acme Proposal in 
Word for Windows, you would use a command line like this:

 C:\PROPOSAL\ACME.DOC 

The file ACME.DOC will automatically load when you click on the icon to start Word for
Windows.

You can start any application's data file from Program Manager, as long as the 
file is associated with that particular application. The association is based on the data
file's extension. For example, if the Acme proposal had an extension not recognized 
by Windows, such as .PRO, Program Manager would not recognize the file as 
belonging to Word for Windows. You'll know when this is the case because a DOS icon
instead of the regular application icon will appear once you have finished editing the 
icon's properties.

To remedy the situation, open File Manager and locate the file, ACME.PRO. 
From the File menu, choose Associate, and in the dialog box that appears enter the 
name of the executable file for the application that you want to run with the file 
loaded. In this case, you would specify WINWORD.EXE. Now when you go back to the 
ACME.PRO icon in Windows, you can bring up the Properties dialog box again, and 
then close it. The Word for Windows icon will reappear.

When you are done working on the Acme proposal, you can delete the Acme 
Proposal group that you created, or simply edit it to reflect the next task.

Streamline Program Groups Don't clutter program groups with more icons 
than you can view in a window. It doesn't do you any good to have to navigate 
through a Program Group window to find your important applications. To keep things 
tidy, remove those accessories and applications that you seldom use and put them in
group that remains minimized. On the rare occasions that you need these items, you 
can simply open the minimized group to get at them. Putting them out of sight makes
for a neater desktop, and allows you to find what you need more quickly.

Start the Day with a Clean Slate To make sure that your desktop is 
always in the same condition-with your frequently used applications right where you 
need them and your seldom used ones out of sight-make sure that the Save Settings 
option is not selected. In Windows 3.0, the Save Settings option appears when you 



exit Windows; in Windows 3.1, it is located on the Options menu, where it is called 
Save Settings on Exit. Use Save Settings when you want to change your program 
group setup, but deactivate it after the change takes effect. If the Save Settings 
option is always selected, your desktop will start out the way it looked when you 
ended your last Windows session.

Toward a Tidier Desktop Windows' great ability to open lots of files at once is
also its greatest trap. How are you going to find anything with 17 layers of windows 
to sort through?

Two of the choices on Program Manager's Options menu look complicated at 
first glance, but they are really handy housekeeping tools for tidying your desktop 
with a keystroke. Both Auto Arrange and Minimize on Use operate only when you click
on them to put a check mark beside them.

Auto Arrange prevents your icons from obscuring other icons on the screen. It 
keeps the Program Item icons in neat rows and columns. Even if you move icons 
around in a window, if Auto Arrange is selected they will come up in neat rows the 
next time you open the Program Group.

Minimize on Use reduces the Program Manager to an icon whenever you run 
an application. This keeps the Program Manager screen and program group windows 
from distracting you while you work. You'll have to restore the Program Manager to its
normal size when you quit the application, but if you tend to keep lots of different 
documents open, you're better off keeping your desktop uncluttered and making the 
extra effort to reopen Program Manager when you need it.

If you wish, you can also neaten your Windows screen by arranging your on-
screen Windows. From the Program Manager's Windows menu, you can choose to 
cascade your program groups so that they overlap step-wise, or tile them so that 
they line up side by side without overlapping.

Modify Program Item Properties There are three program item properties: 
Description, Command Line, and icon. You've already encountered the first two when 
adding a program item, and you can modify them anytime you want by using the 
Properties option on the Program Manager File menu. Just highlight the program icon 
and follow the same procedure you used when you first added the item.

If you've copied a program item into the same program group, chances are 
you want to modify it to load a different file. (See the section "Load a Data File from 
an Icon," later in this chapter.)

The other property you can modify is the program item's icon. Many Windows 
applications are shipped with more than one icon. And, if you'd prefer, you can 
appropriate an icon from another program and assign it to your program.

Especially handy sources for icons are PROGMAN.EXE, the Windows Program 
Manager, and CONTROL.EXE, the Windows Control Program. Nine nicely drawn icons 
are available from PROGMAN; 14 are available from CONTROL. Windows 3.1 also 
comes with the dynamic link library, MORICONS.DLL, which provides many more 
icons to choose from. To find icons, use the Program Manager File menu. Click on 
Properties and then select the Change Icon command button from the Program Item 
Properties dialog box. You'll see the icons currently associated with the selected file. If
you want to see more icons, type:

 C:\WINDOWS\PROGRAM.EXE

in the File Name text box and press Enter. You'll see the icons from that file. You could
also type MORICONS.DLL to see the icons in that file.

Spare icons are particularly useful if you're installing standard DOS 
applications, which have no icons of their own.



Point Browse in the Right Direction When you use the Browse button 
in the Program Item Properties dialog box to locate the file you want to place in the 
Command Line text box, save time by pointing it in the right direction. If you specify 
a directory in the Working Directory text box before you press the Browse button 
you'll be taken directly to that directory. See Figure 5.2.

Program Group Strategies
There's more to making the most of Program Manager than just creating program 
groups. You must also make sure that Program Manager doesn't unduly drain Free 
System Resources (FSRs). A system resource is a morsel of information stored in a 
memory compartment allocated to USER.EXE, one of the three principal program 
modules that make up Windows. That memory region, USER.EXE's local heap, can be 
no larger than 64K, no matter how many memory chips and disk sectors your system 
possesses. Each time you open a window, a descriptor file for that window eats up 
precious resource space.

64K would seem to be an ample amount of space for your needs; after all, 
how many windows will you have open at one time? Unfortunately, however, the 
definition of a window includes all sorts of graphical objects as well. Dialog boxes and
their associated lists, boxes, and buttons are windows. So are icons of all kinds. Other
bits of data-information about menus, for example-also end up in the system 
resource space. Applications usually clean up after themselves when you close them. 
But on most systems, Program Manager is the one application that never closes, so it
never releases its resource space. And you need Program Manager running, since its 
main business is to display windows in the form of program groups and icons-without 
it Windows isn't worth running. You must make sure Program Manager leaves enough 
Free System Resources for your other tasks.

Check the Status of Free System Resources  To check the status of 
your Free System Resources, open the Help menu in Program Manager and choose 
About Program Manager. You'll see the amount of memory you have available, and 
the amount of Free System Resources (expressed as a percentage). To see how much 
of your FSRs Program Manager alone is using, check About Program Manager when 
you start Windows, before you launch any programs or do other operations. Your 
system may run into trouble if FSRs get below 20 or 25 percent.

A Program Manager Diet To keep the amount of Free System Resources that 
Program Manager uses to a minimum, do the following:

Use the About Program Manager command (located on the Program Manager and File
Manager Help menus) periodically. The dialog box that appears tells you how much 
memory and resource space is available. When that number drops below 25 percent, 
close some programs or documents immediately.

Keep your Program Manager setup simple. Create one group with the program icons 
that you use every day; keep other group windows minimized. Icons don't consume 
resources until the group windows are opened, but once used, the space cannot be 
reclaimed.

Launch programs without the use of icons by adding them to the Load= or Run= line 
of your WIN.INI file or by clicking on their filenames in File Manager. When you launch
applications this way, you won't waste the system resources required for their icons 
and for the other icons located in the same program group.



Watch out for "resource leakers." Certain programs (including early versions of 
PowerPoint and PackRat 3.0) do not return all of their resource space when you close 
the application. Repeatedly opening and closing such applications drains resource 
space. To check for resource leaks, use the About Program Manager option on 
Program Manager's Help menu. If your program "leaks," use it sparingly (and 
complain to the vendor).

Consider replacing Program Manager with a shell that is less resource intensive.

Save Program Manager Settings without Actually Exiting If you 
want to save changes to Program Manager without having to exit and restart 
Windows, here's a trick to make Windows save your changes. Start a DOS session, 
switch back to the Program Manager, and attempt to exit by pressing Alt+F4. 
Windows brings up the dialog box saying that you are exiting Windows (and asking 
whether changes will be saved). Select Save Changes and then click on OK. Windows 
attempts to exit and in doing so writes your Program Manager changes to the 
PROGMAN.INI file. However, when it realizes that you have a DOS session running, it 
displays a dialog box telling you that you can't exit while there's a DOS application 
running. You are still in Windows and can keep working along, while your changes 
have already been written to disk. When you really do exit, make sure the Save 
Settings option is turned off again. This approach works in both Windows 3.0 and 3.1.

Use the Shift Key to Save Changes You can save your Program Manager 
configuration without exiting Windows 3.1 by simply holding down the Shift key while 
choosing Exit from the File menu. This obviates the need to use the Save Settings on 
Exit switch on the Options menu and makes saving much simpler and quicker. You 
may think nothing has happened, since no messages appear, but if you exit and 
reload Windows, you'll find that the settings have been saved.

Taming On-Screen Windows
Through Program Manager, Windows allows you to be logical in the organization of 
your applications and efficient in the use of your system; happily, it also allows you to
fine-tune the way your PC environment looks. This sounds like a small thing, but it's 
not. We spend hours in front of our PCs, and yet we've been forced to stare at 
completely generic screens with no individuality, no style, no personality. No more. 
Now, you can make your PC wake up each day looking precisely as you wish. More 
comfortable computing could be the biggest productivity boon of them all!

Broader Borders If you have a tough time sizing windows because you can't get
ahold of their borders with your mouse, increase the border width. To do so, select 
Desktop from the Control Panel and locate the Sizing Grid box-it's in the lower-left 
corner of the Desktop dialog box. Increase the number of the Border Width setting 
(you can choose from 1 to 50) until the borders are large enough for you, and then 
click on OK.

Window Adjustments If the Windows layout on your screen looks haphazard, it's 
easy to fix. Take advantage of Windows' Granularity setting to create an invisible grid 
to which your windows and icons will align. To adjust the granularity, double-click on 
the Control Panel's Desktop icon and locate the Granularity setting in the Sizing Grid 
box (in the lower-left corner of the Desktop dialog box). Click on the up or down arrow
to increase or decrease the value in the Granularity text box (from 0 to 49). To see 
the effect, close the dialog box and move a window. If the granularity is a low value, 
the window will move in tiny increments. The higher the granularity, the larger the 
invisible grid that the window snaps to.



PROGMAN.INI: A Potent Tool
Windows uses a file called PROGMAN.INI to set up and manage program groups. As 
with WIN.INI and SYSTEM.INI (described in Chapter 2), intelligent use of PROGMAN.INI
gives the sophisticated user precision control of the screen.

Use Multiple PROGMAN.INI Files  Suppose you sometimes run Windows 
with a specific set of applications in one mode, and distinct applications in another 
mode. For example, suppose you are running Windows 3.1 and prefer to run in 
Standard mode when you're using just Windows applications, but you like to use 
Enhanced mode for DOS sessions. In this situation, you can create separate 
PROGMAN.INI files that make the most of your system's resources. Doing this allows 
you to keep Program Manager uncluttered, while also cutting down on the amount of 
system resources required for maintaining groups you'll never use.

For example, to create a PROGMAN.INI file for use with DOS applications in 
386 Enhanced mode, do the following:

1.In Program Manager, select New from the File menu, check the Program Group 
radio button, and click on OK. Call the group Enhanced Mode Applications. Click on 
OK and the group appears.

2.Next, create icons for each application you want included in the group by filling out 
the Program Item Properties dialog box for each. Alternatively, if icons for the 
programs already exist in different Program Manager groups, drag the icon from its 
old location to the newly created group. (See the section "Adding a Program to a 
Group" earlier in this chapter.)

3.Open the PROGMAN.INI file in Notepad or another text editor, and before you edit 
it, save it as PROGMAN.ENH (for Enhanced mode). Now find the [Groups] section and 
delete references to any program groups of applications that you'd never run in 
Enhanced mode. For example, if your DOS applications were in a group called 
Enhanced, the entries might look like this:

Group1=C:\WINDOWS\OTHER.GRP
Group2=C:\WINDOWS\MICROSOF.GRP
Group3=C:\ENHANCED.GRP
Group4=C:\WINDOWS\MAIN.GRP

Deleting the second line, which refers to the group titled Microsoft Applications 
(which contains only Windows Applications), will remove it from the Program Manager
the next time you start up in 386 Enhanced mode, saving resources.

4.After making any changes, save PROGMAN.ENH and now reopen your original 
PROGMAN.INI file. This time, delete the line that refers to the Enhanced Mode 
Applications group. Save this edited version of the PROGMAN.INI file as 
PROGMAN.STD (for Standard mode).

5.Next, create a batch file that lets you run the correct version of PROGMAN.INI when
you start Windows. Open a new file in any text editor and type the following lines for 
the file that will start Windows in Standard mode:

COPY C:\WINDOWS\PROGMAN.STD C:\WINDOWS\PROGMAN.INI
WIN /S 

6.Save this file as WINS.BAT (for Windows, Standard mode).



7.Create another batch file named WINE.BAT (for Windows, Enhanced mode). The 
lines in that file look like this:

COPY C:\WINDOWS\PROGMAN.ENH C:\WINDOWS\PROGMAN.INI
 WIN /3 

8.Now you can type Wins to start Windows in Standard mode with your Windows 
applications available. To start Windows in Enhanced mode without your Microsoft 
Applications group, type Wine.

Restrict Your PROGMAN.INI In Windows 3.1, the PROGMAN.INI file contains a
new section that is intended for network administration, but it can help protect your 
system from unwanted (or accidental) changes. The [Restrictions] settings allow you 
to prohibit the Program Manager setup from being changed.

The two applicable entries are NoSaveSettings= and EditLevel=. A 
NoSaveSettings setting of 1 disables the Save Settings option on the Program 
Manager's Options menu. With this option, any changes made to the Program 
Manager's arrangement will not be preserved.

The EditLevel settings specify different levels of access to Program Manager 
commands. A setting of 1 prevents the creation, deletion, and renaming of program 
groups by removing the New, Move, Copy, and Delete commands from the Program 
Manager's File menu only when the Program group option is selected. A setting of 2 
prevents the creation or deletion of both program groups and program items by 
removing the New, Move, Copy, and Delete commands from the Program Manager's 
File Menu altogether. A setting of 3, in addition to altering menus, prevents you from 
typing changes to the command lines for program items. A setting of 4 also prevents 
changes to the program item information. If you select this level, all of the Program 
Item Properties dialog box options will be dimmed.

To prevent any changes whatsoever to your Program Manager setup, add the 
[Restrictions] section to PROGMAN.INI (if it does not already exist). Open the file in a 
text editor, scroll to the end of the file, and add the following entries:

 [Restrictions]
 EditLevel=4
 NoSaveSettings=1

Making the Most of the Program Groups That 
Windows Provides
Windows establishes four program groups automatically at setup: Main, Accessories, 
Startup, and Games. Main contains the Control Panel, PIF Editor, and other 
operational programs; Accessories holds small applications that Windows provides 
(they are discussed in Chapter 6); Startup is empty, but it can be used as a location 
for applications you would like to run at Windows start-up.

Although the creation of these groups is automatic, they can be used wisely 
by the savvy user.

Tips for Control Panel Control
Aspects of the Main Program Group are covered in many places in this book. The PIF 
Editor is discussed in Chapter 4, the File Manager in Chapter 6. Many of the icons in 
the Control Panel are direct expressions of statements in the *.INI files covered in 
Chapter 2. Here, we will touch on aspects for controlling the Control Panel itself, then 



we'll move on to making the most of the Control Panel Desktop, which oversees the 
look and feel of the Windows screen environment.

Select Settings with Quick Keystrokes You're probably used to 
starting Windows applications and accessories by double-clicking on their icons. 
While you will probably select Control Panel choices with the mouse too, this may not 
always be the quickest way. If you prefer using the keyboard to the mouse, or if you 
sometimes have difficulty locating just the right icon from the bunch, you'll want to 
use the Control Panel's Settings menu to launch the item that you want to use. To 
access the menu, press Alt+S, and then press one of the following letters that 
represents the desired Control Panel module:

C  Color
F  Fonts
O  Ports
M  Mouse
D  Desktop
K  Keyboard
P  Printers
I   International
T  Date/Time
N  Network
3  386 Enhanced Mode
R  Drivers
S  Sound

Start the Control Panel from Anywhere in Windows 3.1 When you
decide that you suddenly need to change something in Windows, such as the desktop
colors, the speed of your mouse, or the fonts that are installed, it isn't always easy 
getting to the Control Panel and its many icons. If you have several applications 
open, you may have to hunt around for the program group that contains the Control 
Panel icon, and then you have to locate the icon you need. But there is an easier way.
You can directly access a Control Panel item by using the Run option on the Program 
Manager's File menu. For example, to open the Control Panel's Desktop icon, you 
would select Run from the Program Manager's File menu and then type control 
desktop in the Command Line text box, as shown in Figure 5.3. You can use this 
method for any of the Control Panel icons. Just specify its title after the CONTROL 
command.

Keep Control Panel Icons Out of Sight in Windows 3.1 If you 
share your system with other users and don't want them to be able to tamper with 
your Windows setup, there is a way to keep Control Panel icons out of sight. You can 
selectively hide Control Panel icons by editing the CONTROL.INI file. To do so, open 
CONTROL.INI in a text editor such as Notepad and go to end of the file. Now create a 
new section called [Don't Load] where you list each icon that you want turned off. 
The setting will look like this:

 [Don't Load]
 Color=1
 386 Enhanced=0
 Drivers=1

Placing either the number 1 or 0 after the equals sign prevents the icon from 
showing up when the Control Panel loads.



Any options made unavailable this way also won't be able to be accessed via 
the Program Manager's Run command, as explained in the previous tip. They won't 
be available until you remove the line from the [Don't Load] section and restart 
Windows.

Sound Off Even a jazzy sound assigned to the Windows warning beep can grow 
tiresome. To turn off this special sound or the regular old Windows warning beep, 
select the Control Panel's Sound icon, and uncheck the check box that says Warning 
Beep (Windows 3.0) or Enable System Sounds (Windows 3.1).

Device Contention and Problem Prevention If you run Windows in 
Enhanced mode, you'll notice a 386 Enhanced icon in the Control Panel. The first 
setting in the 386 Enhanced dialog box is for Device Contention. This setting tells 
Windows whether it should monitor the use of your system's ports. In Windows 3.0 it 
handled both serial and parallel ports, while in Windows 3.1 it only monitors the serial
ports. If a DOS application and a Windows application attempt to use a port at the 
same time, Windows can warn you of this potential problem. For example, if a Lotus 
1-2-3 file and a Microsoft Word for Windows file attempted to print to COM1 at the 
same time, Windows would tell you to choose to print one document or the other 
first. To have Windows warn you of a potential conflict, select the Always Warn option 
button.

Redecorate Your Screen with Control Panel's Desktop
The decoration of the Windows screen is managed by a program within the Control 
Panel, the Windows Desktop. Here, you can select wallpaper, borders, and textures 
for your Windows screen. In this section we offer a serving of tasty decorating hints 
for the Windows desktop.

Wallpaper Choices By this time, everyone knows about Windows wallpaper, the 
decoration that lies behind all Windows screen objects. Windows wallpaper can be 
anything you want it to be: any pattern, any line drawing, any painting, any scanned 
image.

Windows offers several wallpaper patterns, but as with every colorful and 
graphic aspect of Windows, you can easily add your own. To access the Windows 
wallpaper patterns, click on the Desktop icon from the Control Panel and locate the 
Wallpaper item in the Desktop dialog box. There's a drop-down list of wallpaper 
filenames carrying the .BMP filename extension, which means they are Windows 
Paintbrush bitmap files.

Wallpaper patterns can occupy a whole screen or, if they're smaller than a 
whole screen, can be tiled. The advantage of smaller patterns is that they occupy 
less disk space and, more importantly, less PC memory when they're in use. All 
Microsoft-supplied patterns must be tiled, although some are relatively large and 
require as few as four copies to fill the screen.

Windows wallpaper is easy to create. Because it comes in .BMP format, 
anything that you can create with Windows Paintbrush is fair game to become 
wallpaper.

Simply get into the Paintbrush program (it's in the Accessories group window) 
and draw away. When you're done, save the file in the directory where Windows is 
stored. Then open the Desktop in the Control Panel and select the Paintbrush file you 
created from the list in the Wallpaper section of the dialog box to load your new 
wallpaper onto your desktop. If you don't like what you've got, go back to Paintbrush 
and give it another shot. We discuss Paintbrush more fully in Chapter 6.

If you don't fancy yourself an artist and don't want to create wallpaper from 
scratch, there are other ways of obtaining Windows wallpaper. If an image in another 



Windows application, or even a DOS application (not running in text mode) is to your 
liking, you can capture the image using the Clipboard and save it as a .BMP file from 
the Clipboard. For example, say you're running Tetris in a DOS session and think that 
a shot of falling tiles would make great wallpaper. Press the PrtSc key to capture the 
image to the Clipboard. Then open Paintbrush and select Paste. The screen image will
appear, ready for you to edit or save as a .BMP file. Remember to store the file in the 
directory where Windows is located so that it will appear as a wallpaper choice in the 
Control Panel's Desktop dialog box.

You can also scan an image into your PC and convert it to the .BMP format. If 
your scanner software produces .PCX files, Paintbrush can convert them to .BMP files.
Plenty of conversion programs are available, including some that are shipped with 
scanners that convert files to the .PCX format, so you shouldn't have trouble finding a
route to wallpaper compatibility.

Other sources of wallpaper include almost any graphics program that 
produces, or can be converted to, a compatible file. For example, you might want a 
business graphic (such as your company's logo) on your screen when you shut down 
the rest of your applications or convert them to icons. Bulletin boards and on-line 
services are other great sources for .BMP files to use as wallpaper. 

Wallpaper versus Patterns If you're short on memory but still crave that 
Windows decorator touch, opt for a desktop pattern instead of wallpaper. Patterns 
use less memory than wallpaper because they contain smaller bitmap images. You 
can find patterns along with wallpaper in the Control Panel Desktop.

Custom Desktop Patterns The patterns that come with Windows do liven up 
your desktop a bit, but you can go one better by editing them to create your own 
patterns. While you do have to work from one of the original patterns, you'll find that 
you can essentially get a blank slate in one of two ways. First, go to the Control 
Panel's Desktop dialog box and select Edit Pattern. You'll see a box containing the 
selected pattern. Hold down the left mouse button and "wipe" away the pattern as 
you wish, leaving areas clear. Alternately, you can draw by clicking on clear areas to 
darken them. Try creating a pattern with your initials as the motif, as we did in Figure 
5.4.

When you create a new pattern, make sure to change the name in the Name 
Text Box so that you don't overwrite the original pattern. Once you've named your 
new desktop pattern, you can add it to your list of choices by selecting Add. This is 
important, because if you forget to press Add and return to the main Desktop dialog 
box, your work of art will be lost.

Color Secrets
The natural partner for the Windows Desktop dialog box is the Color dialog box, 
whose icon is also found in the Control Panel. Here, you can select colors for every 
part of Windows, either from a large palette of predefined colors or by mixing your 
own hues.

The entire set of Windows colors you use is called a color scheme. There's no 
limit to the number of Windows color schemes that you can save, swap, and reuse. 
That means you can use one set of colors in the morning, another for lunch, and a 
third during the late afternoon.

You'll probably want the most visible elements to be easy on your eyes. To 
help you choose aesthetically pleasing combinations, Windows provides several 
predefined color schemes as well as a set of tools for modifying them or creating 
schemes of your own.



Use Built-In Color Schemes The default color scheme that comes with 
Windows is an unexciting combination of blue and gray, but you can use the Control 
Panel to choose one of the other predefined schemes that suits your taste. Select the 
Color icon in the Control Panel to bring up the Color dialog box. You'll see the Color 
Schemes box with Windows Default selected. Scroll through the choices to select 
another color combination for your desktop. The color scheme names describe their 
tonal qualities. For example, Bordeaux consists of a series of winelike purples, while 
the Arizona scheme conjures sandy desert tones, and Ocean paints the screen with 
sea blues and greens. Simply scroll to one of the set color schemes, and then click OK
to put it in action.

Do-It-Yourself Schemes If you like some but not all of the colors in the 
scheme you've chosen, you can go back to the Color dialog box to make a modified 
version. Click on the Color Palette command button, and the half-screen Color dialog 
box will double in width to present a color table and another drop-down list box 
containing all the Windows screen elements. Ten graphic elements plus ten text 
elements make up the Windows desktop, and you can make each element any color 
you want.

The color table accommodates a wide range of colors in two parts: the larger 
section, at the top, contains basic colors, while the smaller section, at the bottom, 
contains boxes in which you can define custom colors. To pick a color for any 
Windows desktop element, click on the element in the model window on the left side 
of the screen or select it from the Screen Element drop-down list box on the right 
side. Then choose a color for the element by clicking on the appropriate color box in 
the color table. The miniature window on the left changes immediately, revealing the 
effects of your new color choice.

Windows colors, whether basic or custom, are either solid or nonsolid 
(nonsolid colors actually consist of a solid color interspersed with pixels of an 
alternate color). The number of available solid colors depends on the type of video 
adapter you have.

Change as many colors as you like, and then click the OK button. Your desktop
will change colors to reflect the colors you chose. If you like what you see, name and 
save your custom scheme by clicking the Save Scheme button, entering a name for 
the scheme, and clicking on OK. Thereafter, it will appear on the list of available set 
color schemes.

Create Your Own Colors If you're unhappy with the colors in the basic color 
table, make your own. When you click on the Define Custom Colors command button 
in the Color dialog box, a rectangular implementation of a color wheel appears on the
left side of the screen, as shown in Figure 5.5. Grab the color cursor and move it until 
the color sample is the color you want. As you change colors you'll notice the values 
in the boxes at the bottom of the dialog box change. You can control aspects of colors
by entering values here. Finally, you can darken or lighten a hue by moving the arrow
along the color bar on the right of the custom color selector dialog box.

When you've found the color you're looking for, click an unused box in the 
Custom Colors table to select it, and then click on the Add Color command button. 
After that, you can use your new color wherever you want.

Add a Pattern to Your Desktop Color The simplest way to add interest 
to your desktop is to overlay the color with a textured pattern. Microsoft supplies 
several patterns with Windows, ranging from a 50-percent gray pattern, which simply
alternates colored pixels with white ones, to patterns depicting dogs, flowers, and 
propellers.



To add a textured pattern, select the Desktop icon from the Control Panel. The 
Pattern box displays the current desktop pattern in a drop-down list box. Click on the 
down arrow to list the original Microsoft-supplied choices, select one, and then click 
on OK. If your desktop is visible and it's painted a color other than white, you'll 
immediately see the results of the change.

More Color Control for Windows 3.0 Windows 3.1 lets you apply color to 
more desktop items than version 3.0 does, including those items that define on-
screen buttons. (See Figure 5.6.) To change the colors of these elements in Windows 
3.0, you'll have to add entries to the [Colors] section of the WIN.INI.

You can use the following settings in the [Colors] section of the WIN.INI to 
change the color of Windows 3.0 help text:

ButtonFace Color of the button face

ButtonShadow Color of the button shadow

ButtonText Color of the button text

GrayText Color of text that is unavailable in a menu or dialog box

Hilight Color of the background of highlighted text

HilightText Color of the highlighted text itself

The format for each of these settings is to specify the red-green-blue (RGB) 
value of the color for the desktop element. To find out this setting for the color that 
you want, open the Color dialog box via the Control Panel. Select Color Palette, and 
then select Define Custom Colors to open the Custom Color Selector. You'll notice 
boxes for the Red, Green, and Blue color values, as well as a square palette that lets 
you drag a cross-like cursor to the desired color. A vertical bar shows the current 
color listed. Experiment with the three values to come up with the colors you desire. 
Or if you know the colors you want, drag the cursor to that location. Then jot down 
the corresponding red-green-blue values for your desired colors so that you can 
easily edit the WIN.INI file. For example, to set the ButtonFace color to blue and the 
ButtonText color to black, you would add the following lines to WIN.INI's [Colors] 
section:

 ButtonFace=0,0,128
 ButtonText= 0,0,0

One color choice that you may want to change is that of the GrayText. 
GrayText is often hard to read when an option isn't available. If you change it to a 
darker color, at least you'll be able to read what options you're missing out on.

Change the Cursor Color While there is no default option for changing the 
color of the blinking cursor in Windows, there is a way to change it indirectly. That's 
because the color of the cursor is always the inverse of the Window Background 
Color. After you change the Window Background color in the Color dialog box of the 
Control Panel, you'll have to open an application to see what color the blinking cursor 
becomes. (The blinking cursor isn't visible in Program Manager.) For example, when 
the Window background is blue, the cursor is yellow; when the background is yellow, 
the cursor is blue. Experiment with different background and cursor colors until you 
find a combination that you like.



Personalize the Windows 3.1 StartUp Group
By placing a program item in Windows 3.1's StartUp group, you can automatically 
load a program you use every day when you start Windows. But you can go one 
better by customizing PROGMAN.INI so that any one of your program groups loads 
automatically. With this method, your regular StartUp group stays intact but is 
disabled, and you won't have to shuffle the contents of another whole program group
into it.

To change the StartUp group, open PROGMAN.INI in Notepad or another text 
editor. In the [Settings] section, enter the name of the group whose applications you 
want to load automatically every time you start Windows. For example, if you want to
change the StartUp group to the program group entitled Quarterly Report, your 
PROGMAN.INI might look like this:

[Settings]
Window=60 28 565 388 1
SaveSettings=1
MinOnRun=0
AutoArrange=1
Startup="Quarterly Report"

This technique is especially handy if you're working on a new project and want
to load a suite of files automatically when you start Windows. When you're done with 
the project, go back to your default StartUp group by deleting the group name you 
added after Startup=.

Set the Loading Order of the StartUp Group To change the loading 
order of the applications in the Program Manager's StartUp group, simply rearrange 
the order of the icons. The programs are launched in order from left to right.

Bypass the StartUp Group The StartUp group is a great time-saver because it
automatically loads the applications you generally use when you start Windows. But 
there'll be times when you want to get to Windows without waiting for these 
applications to load. For example, say you forgot to reply to an e-mail message 
before you exited Windows, and now you just want to go directly to your e-mail 
application and dash off a reply. To override the StartUp group applications, press the 
Shift key while Windows is loading (during the Windows logo screen or on the blank 
screen if you've disabled the Windows logo). You'll end up in Program Manager and 
will be able to quickly get to the task at hand.

Recreate the StartUp Group To restore a StartUp group you deleted 
accidentally, simply create a new group and name it STARTUP; Windows 3.1 will 
recognize that it should automatically load the contents of this group at Windows 
startup.

Icon-ography and Creative Dragging
Windows offers two metaphors for control and identification of your intent: One is an 
icon, the tiny on-screen picture that represents an application, and the other is 
motion, the movement of an icon or other screen element from one place to another. 
By cleverly using both these methods, you can play the Windows screen like an 
instrument.

The Hidden Power of Icons



Windows applications generally come with their own nifty icons that load 
automatically. All you have to decide is which program group to place the icon in. 
However, you can create your own icons, assign new applications to existing icons, 
and otherwise manipulate these symbols to your own ends.

Create Your Own Icons for DOS Applications To create your own icons
for your favorite DOS applications, you need an icon editor; there are several 
shareware programs that will do the job nicely, such as Icondraw, Icon Magic, and 
IconMaster. Once you've created and saved an icon, assigning it to a DOS application 
is a five-step process:

1.In the non-Windows Applications window (or wherever you've stashed your DOS 
applications), highlight the program whose icon you want to change by clicking on it 
once.

2.Select Properties from Program Manager's File menu.

3.Press the Change Icon command button in the Program Item Properties dialog box.

4.In the File Name text box, enter the full path and filename of the .ICO file that 
contains the icon you created.

5.Click OK twice to confirm your selections.

Bulletin boards and on-line services also include a wide variety of icons that 
others have created for popular DOS applications. If you look around a bit, you'll 
undoubtedly find some icons that are just right for your DOS applications.

Adding an Original Icon You don't have to settle for Program Manager's 
default DOS icon for character-mode applications. Instead use any image: a picture of
Elvis, a golf club, a favorite cartoon character.

All you need is a collection of icons or an icon editor. Both are available on 
various bulletin board systems. Investigate the file libraries. You'll find dozens of 
icons (most have the extension .ICO or .ICN) ready for downloading-everything from 
sober, businesslike icons for leading applications such as 1-2-3, WordPerfect, and 
dBASE to cartoon characters like Calvin, Hobbes, and Bugs Bunny. Download the 
likely suspects, decompress them, if necessary, and you're all ready to go.

To attach one of your new icons to an installed application, highlight the 
application's current icon and select Properties from Program Manager's File menu. 
Then choose the Change Icon command button in the Program Item Properties dialog 
box. Your application's filename and its current icon will appear. Replace that 
filename with the name of the icon file you wish to substitute (HOBBES.ICO, for 
example). Then press View Next and your new icon will be displayed. If you like what 
you see, click on OK. The new icon will appear.

Easy-to-Find Icons If your program groups are cluttered with icons whose 
names are running into each other, you can use these tips to tidy up. Adjust the icon 
spacing to allow more room for each icon and its title by selecting Desktop from the 
Control Panel and changing the icon spacing to a larger number (the minimum is 32). 
The default is 75 pixels and the maximum is 512, but anything over 100 pixels takes 
up too much real estate on most monitors. Once you make the adjustment, you'll 
have to select Arrange Icons to see the new layout. In version 3.1, Desktop also has a
Text Wrap option, which permits icon titles that are many lines in length; check this 
option for more flexibility.



A Timely Icon Here's a way that you can always see what time it is when you're 
working in a Windows application-without fooling with the cumbersome default clock 
display.

Double-click on the Accessories icon and then double-click on Clock. Click on 
Settings, then on Digital, and then use the Minimize command to reduce the clock 
display to an icon. This places a relatively small, easy-to-read, working digital clock 
icon at the bottom of your Windows display. And, of course, you can use your mouse 
to drag the clock icon anywhere you like.

Start Program Manager as an Icon You may want to start Program 
Manager as an on-screen icon instead of as a window. Maybe you've got some great-
looking wallpaper that you'd rather look at. You have two options for doing this: You 
can minimize Program Manager and exit Windows, checking the Save Settings option 
for this time only. When you do this, the next time you start Windows, Program 
Manager will be still be minimized. Alternatively, you can edit your WIN.INI file and 
add the Program Manager's executable file, PROGMAN.EXE, to the Run= line.

Load Applications as Icons  To load a Windows application automatically as
an icon, hold down the Shift key while double-clicking on the name of its on-screen 
icon in the program group. When an application is run this way, its identifying icon is 
placed at the bottom of the screen for future use rather than being loaded into an 
active window.

Load a Data File from an Icon Everyone has a certain method for 
organizing data files-be it by document type, month, or project. But most people 
don't store files in the directory of the application that creates them. (This isn't a 
good idea anyway, because if you upgrade or remove an application the files may get
lost in the shuffle.) With many programs, this means you have to switch to the 
appropriate data file directory every time the program loads. Windows 3.1 eliminates 
this headache by letting you specify a distinct working directory for the application. 
From this start, you can move on to creating icons that pull files directly from this 
directory and automatically load the application that runs them!

In Program Manager, select the icon of an application and choose Properties 
from the File menu. In the text box labeled Working Directory, enter the path of the 
directory where you keep most of your current data files. Update the directory as 
your needs change-for example, when you start a new project. 

If you frequently need access to files that don't belong in this working 
directory, consider making unique icons for those data files that automatically access
the proper directory. To do so, choose New from the File menu in the Program 
Manager, make sure Program Item is selected, and click on OK. Enter a description 
for the file, and, in the Command Line text box, enter the path and filename of the 
data file. If you can't remember the exact filename, or if it's buried several 
subdirectories deep, select the Browse command button to find it. Then select the 
working directory and choose whether you want a shortcut key to load it quickly.

For this data file to launch its parent application, it must be associated with 
the application. For example, a Word for Windows document with the default .DOC 
extension will load automatically, but one with your initials as the extension won't. To 
associate the file, start File Manager, highlight the data file, and choose Associate 
from the File menu. In the Associate With list box, select the correct file type, in this 
case Word Document. For more on File Manager, see Chapter 7.

You can also launch an unassociated file by putting the entire path and 
filename in the Command Line text box of the Program Item Properties dialog box, 
following the program filename. For example, you could enter



 C:\WINWORD\WINWORD.EXE C:\PROPOSAL\COVER.LET

Run Multiple Data Files from a Single Icon Once you've set up an 
icon to launch a data file and its parent application, make it do double duty. You can 
launch multiple data files from the same application by adding their names to the 
Command Line text box in the icon's Program Item Properties dialog box. For 
example, to launch another letter in addition to the one shown earlier, you would use 
a command line like this:

C:\WINWORD\WINWORD.EXE C:\PROPOSAL\COVER.LET C:\PROPOSAL\NOTES.DOC

The filenames must be separated by a single space, and the file directory must be 
located in your DOS PATH statement. See Figure 5.7.

The Ins and Outs of Dragging and Dropping
Clicking isn't the only way to get power from a mouse in Windows. You can also use 
the mouse to move objects around the screen using Windows' drag and drop 
capabilities. You drag a file by selecting it with the mouse and then holding down the 
left mouse button while moving the mouse. You drop the file by releasing the button 
when the mouse arrives at its destination. Done correctly, this allows you to 
accomplish with one quick motion what it might take far longer to type or manage 
with menus. Drag and drop is one of Windows' least understood and used features.

Create an Icon with Drag and Drop Using the File menu isn't the only way
to create an icon. If you have File Manager and Program Manager open, grab the File 
Manager icon for the file (either an executable file or an associated data file) and 
drag it to the program group where you want it to be. Drop the file icon, and the 
Program Manager icon for the application appears in the desired group, as shown in 
Figure 5.8.

Open a File with Drag and Drop To open an application file without having 
to wade through menus, use drag and drop. Here's a trick that works with many, but 
not all Windows applications. Using Windows File Manager (which is discussed more 
fully in Chapter 7) select the data file that you want to load and then drag it onto the 
title bar of an open application. The application will load the file. If the application is 
not already running, you can drop the file onto the application's icon, and the 
application will start up, with the data file loaded.

Savvy Shortcuts for the Screen
Menus form the backbone of Windows' interface. You can accomplish some of the 
tasks faster through alternative routes, however. In this section, we'll look at 
shortcuts for the mouse and the keyboard.

Bars and Buttons
Power can be found in the bars, buttons, and borders of Windows applications and 
screen groups. By moving the mouse to these sensitive spots, you can manipulate 
your programs. Exactly what happens varies by program; experiment with and read 
the application tips in Part 2.

Double-Click the Title Bar to Maximize a Window To quickly 
maximize a Program group window or an application window, double-click on the title
bar. If the Window is already maxed, clicking the title bar is equivalent to clicking 
Restore.



You can also maximize the window by clicking on the Maximize button (the up 
arrow located in the window's upper-right corner) or in some applications by pressing 
Ctrl+F10.

Incredible Shrinking Windows Clicking on an open window's Maximize/ 
Restore button (the arrow in the top right corner) to fit the window to the screen is 
easier than resizing it with a mouse or using the Control menu's Maximize or Restore 
command. But because this button is located next to the Minimize button (a down 
arrow), it's easy to click the wrong one.

Fortunately, there's another way: You can toggle between full-screen display 
and shared-screen windows by double-clicking anywhere on the program's title bar-a 
much larger target.

Close a Window Quickly You can quickly close any window (or even Windows 
itself) by double-clicking on the Control menu icon-the small rectangular icon on the 
far left end of the application's title bar. This is a speedy alternative to opening the 
Windows Control menu and then selecting the Close option or using the Alt+F4 
keyboard command.

Do the Windows Shuffle If you're running only one or two Windows programs 
at once, calling up the Task List (Ctrl+Esc) and selecting the relevant window isn't the
most convenient way to switch between windows or slip out to the Program Manager.
It's quicker to shuffle between your open windows by pressing Alt+Tab or Alt+Esc 
until you find the title bar or icon label you want.

Scroll Bar Secrets To easily scroll through the information in a window, keep 
in mind the following mouse shortcuts:

To move one line up or down, click once on the up or down arrow located at the top 
and bottom of the vertical scroll bar.

To move one screen up or down at a time, click in the vertical scroll bar above or 
below the scroll box.

To move one screen left or  right in the horizontal scroll bar, click left or right of the 
scroll box.

To move continuously through the document or list, point to one of the scroll arrows 
(up, down, left, or right) and hold down the mouse button until you get where you 
want to be.

You can also drag the scroll box anywhere you want as you navigate through the 
window.

Find the Perfect Window Size When you've got a handful of Windows 
applications active at once, the perfect window size lets you use just enough of the 
space below the window to see your other program icons at a glance. Manipulating 
windows to just the right size can be a real drag (pun intended).

Fortunately, there's a no-fuss way to resize your windows with one touch. 
First, shrink to icons all applications except for the one that you plan to size. Press 
Ctrl+Esc to bring up the Task List, and click on Tile (or press Alt+T). Your window will 
instantly resize to be as large as possible while still leaving room for a row of icons 
along the bottom of the screen.



Don't Forget the Keyboard
For getting things done in Windows, mice may be nice, but the keyboard is often 
nicer still. Because they have less distance to travel, fingers are usually more nimble 
than forearms-provided, of course, that the fingers know where they're going.

Windows comes with a healthy number of built-in keyboard shortcuts. You can 
increase your Windows agility by getting to know them. Still other keystroke 
combinations may be well established in your own muscle memory (because of your 
experience with certain non-Windows programs) but not employed by your favorite 
applications; you may want to establish these key combinations yourself with the 
help of Recorder, a keyboard macro recording application bundled with Windows. 
(Recorder is discussed in Chapter 6.)

The universal shortcuts include those that give you access to menus and 
those that let you control the size and position of application windows. Both Alt and 
F10, for example, activate the menu bar in any Windows program. If you're coming to
Windows from a DOS program (such as Symphony) that uses F10 for menu access, 
you don't need to abandon that keyboard habit. On the other hand, you may need to 
unlearn the use of F10 for executing commands. If you press Fl0 while in the menu 
system, for example, Windows does not carry out the highlighted command as a 
MultiMate user might expect; instead, it removes you from the menu bar.

Nearly every Windows program includes an Application Control menu, which 
contains commands for maximizing, minimizing, restoring, and closing the 
application window. You activate this menu by clicking the mouse on a bar in a 
square at the window's upper-left corner. This bar looks like the keyboard's spacebar-
a reminder to you that pressing Alt+spacebar also displays this menu.

Document windows, the smaller windows in which you work with files in 
certain applications, have Document Control menus denoted by a shorter bar in a 
box. If you think of a short bar as a hyphen, you won't forget that the access 
combination for Document Control menus is Alt+hyphen.

A substitute for the Application Control menu's Close command, Alt+F4, shuts 
down the active application. In most programs you can use this key combination (or 
Esc) to close the current dialog box without saving any changes. If you find a dialog 
box you can't dismiss with the Escape key, try Alt+F4.

To close the current document window, use Ctrl+F4. To move between open 
document windows, try Ctrl+F6 or Shift+Ctrl+F6. These procedures should work in all
Windows programs that allow multiple documents, even those that don't bother to 
put a Next Window command on their Document Control menus. Document Control 
menus typically include shortcuts for maximizing, restoring, moving, and sizing 
document windows-Ctrl+Fl0, Ctrl+F5, Ctrl+F7, and Ctrl+F8, respectively. If you take 
Windows on the road without a mouse, you'll do well to learn the control-key 
shortcuts.

Two very useful shortcuts appear on many programs' Edit menus: Ctrl+Ins for 
Copy, and Shift+Ins for Paste. If you think of a copy-and-paste operation as an 
insertion at the target location, you'll be able to remember the second half of these 
combinations. You might associate the "C" in Ctrl with the "C" in copy. Many Edit 
menus also offer Del for Clear, and Shift+Del for Cut. Cut puts a copy of the deleted 
matter on the Clipboard, replacing whatever was there before; Clear, on the other 
hand, deletes without affecting the Clipboard's contents. Again, a first-letter 
mnemonic may help you remember the key combination: Think of Shift+Del as a 
command to Store and Delete.

The keyboard is often superior to the mouse for navigating in list boxes. 
Pressing an alphabetic or numeric key in a list always takes you to the next item that 
begins with that letter or number. This seems to be true in all Windows dialog boxes 
and in some contexts outside of dialog boxes. Anytime your favorite Windows 
application presents you with an alphabetical list, try the first-letter express; you'll 
find this method both faster and more accurate than dragging the scroll box.



In most Windows lists, Home, End, Up Arrow, and Down Arrow behave as you 
would expect. Be wary of PgUp and PgDn, however. While these keys generally scroll 
by the windowful, some applications treat them as browse rather than navigation 
keys. In IBM's Current List View, for example, PgDn moves the display without 
changing the selection. No matter how many PgDns you press, the same item 
remains selected.

First-Letter Shortcuts When you press a letter key in a program group, 
Windows selects the next program item that begins with that letter. For example, in 
your Accessories group you can skip from Calculator to Calendar to Cardfile to Clock 
by pressing the letter C successively.

Use Shortcut Keys for Quick Task Switching In Windows 3.1, a new 
program item property allows you to specify a shortcut key for each icon. To set these
shortcut keys, go to the Program Manager File menu and select Properties. In the 
Program Item Properties dialog box, you'll see a text box marked Shortcut Key. Click 
on this text box and type any key or combination. Windows will automatically add 
Ctrl+Alt to complete the shortcut. These shortcuts allow you to switch between 
applications quickly. If you've got seven different tasks running simultaneously and 
you need to get back to your word processor in a hurry, it's simpler to press 
Ctrl+Alt+W than to use the Alt+Tab key combination five or six times. When you're 
selecting these shortcuts, try to come up with a key combination that's easy to 
remember and that reminds of you the application it represents.

Keyboard Shortcuts: Text You can use the following keyboard shortcuts for 
text selection and editing:

Keyboard Shortcut   Function

Backspace Deletes the character to the left of the insertion point, or deletes 
selected text

Del Deletes the character to the right of the insertion point, or deletes selected text

Shift+Home Selects text to the beginning of the line

Shift+End Selects text to the end of the line

Ctrl+Shift+Right Arrow Selects next word

Ctrl+Shift+Left Arrow Selects previous word

Ctrl+Shift+Home Selects text to the beginning of the document

Ctrl+Shift+End Selects text to the end of the document

Shift+Left Arrow or Cancels the selection of a character
Shift+Right Arrow 

Shift+Up Arrow or Selects one line of text up or down; if a line
Shift+Down Arrow  is selected, cancels the selection

Shift+PgUp or Selects text up or down one window; if a window
Shift+PgDn    is selected, cancels the selection



Shift+Del (Cut) Deletes selected text and places it on the Clipboard

Shift+Ins (Paste) Inserts text from the Clipboard at the insertion point in the active 
window

Ctrl+Ins (Copy) Makes a copy of selected text and places it on the Clipboard

Alt+Backspace Undoes the previous editing operation

Keyboard Shortcuts: Characters You can use the following keyboard 
shortcuts for character formatting:

Keyboard Shortcut  Function

Ctrl+B Boldfaces selected characters

Ctrl+I Italicizes selected characters

Ctrl+U Underlines selected characters

F5 Normal, turns off bold, italic, and underlining

Keyboard Shortcuts: Cursor You can use the following cursor movement 
keys for most Windows applications:

Keyboard Shortcut   Function

Ctrl+Right Arrow Moves right one word

Ctrl+Left Arrow Moves left one word

Home Goes to the beginning of the line

PgUp Scrolls up one screen 

PgDn Scrolls down one screen 

Home Scrolls to the beginning of the line

End Scrolls to the end of the line 

Ctrl+Home Scrolls to the beginning of the document

Ctrl+End Scrolls to the end of the document 

Shift+Tab Moves cursor in opposite direction of Tab

Keyboard Shortcuts: Dialog Boxes You can use the following keyboard 
shortcuts for dialog boxes:

Keyboard Shortcut   Function

Tab Moves from option to option

Shift+Tab Moves from option to option in reverse order



Alt+letter Moves to the option whose underlined letter matches the one you type

arrow key Moves from option to option, or within a list or text box

Home Moves to the first item or character in a list or text box

End Moves to the last item or character in a list or text box

PgUp or PgDn Scrolls up or down in a list box, one window at a time

Alt+Down Arrow Opens a drop-down list box

Alt+Up Arrow or Selects an item in a drop-down list box
Alt+Down Arrow 

spacebar Selects or cancels a selection in a list box, or selects or clears a check box

Ctrl+/ Selects all items in a list box

Ctrl+\ Cancels all selections except the current one

Enter Executes a command button, or chooses an item in a list box and executes the
command

Esc or Alt+F4 Closes a dialog box without completing the command

letter Moves to item in the list box that starts with that letter

Keyboard Shortcuts: Menus For menu keys (in any application), use Alt or 
F10 to select the first-level menu on the menu bar. Then use the following keyboard 
shortcuts for menu selection:

Keyboard Shortcut   Function

letter Chooses the menu or menu item whose underlined letter you type

Left Arrow or Moves to the left or right between menus
Right Arrow 

Up Arrow or Moves up or down between menu items
Down Arrow 

Enter Chooses the selected menu item

Esc Cancels the selected menu

Alt+hyphen Opens submenu menu

Keyboard Shortcuts: On-Screen Windows You can use the following 
keyboard shortcuts to manipulate and move between windows:

Keyboard Shortcut   Function

Alt+spacebar Opens the Control menu for an application window



Alt+hyphen Opens the Control menu for a document window

Alt+F4 Closes a window

Alt+Esc Switches to the next application window or minimized icon, including full-
screen programs

Alt+Tab Switches to the next application window, restoring applications that are 
running as icons

arrow key Moves a window if you've chosen Move from the Control menu, or 
changes the size of a window when you've chosen Size

Ctrl+F6 or Ctrl+Tab Repeatedly cycles through open group windows and group 
icons 

Ctrl+F4 Closes a group window 

Keyboard Shortcuts: Program Manager The following keyboard shortcuts 
will work in Program Manager or from within an application that you are running in 
Windows:

Keyboard Shortcut   Function

Ctrl+Esc Switches to the Task List

Alt+Esc Switches to the next application window or the next minimized icon, 
including full-screen program icons

Alt+Tab By repeatedly pressing the Tab key as you hold down the Alt key, you can 
scroll through all current tasks

PrtSc Copies an image of the screen contents onto the Clipboard

Alt+PrtSc Copies an image of the active window onto the Clipboard. If this doesn't 
work, try Shift+PrtSc

Alt+F4 Closes the active application window; pressing Alt+F4 from the Program 
Manager exits you from Windows itself

Alt Activates the first pad on the Menu bar; pressing Alt again closes it

spacebar Places an X in any dialog box check box 

F1 Activates context-sensitive help and displays the Help Index for the application; if 
the Help window is open, displays the Help Index; if you need help filling out Windows
dialog boxes, F1 usually brings up a Help screen that explains options

The following shortcuts work within Program Manager only:

Keyboard Shortcut   Function

Alt+WC and Shift+F5 Cascades windows



Alt+WT and Shift+F4 Tiles windows

Alt+WA Arranges icons

Saves and Captures
A smart user wants to save his or her screen in two ways: first, avoiding burned-on 
impressions from images that stand on the screen unchanged for long periods. This 
saves the screen from fuzziness and eventual uselessness. In a much different 
context, a sophisticated Windows user will want, from time to time, to save the visual
contents of the screen. Screen savers and screen capture programs accomplish these
two tasks, respectively.

Screen Savers
Every good Windows setup should have a screen saver installed and operating. 
Screen savers are programs that blank the working screen and replace it with some 
kind of animated graphic. It's good for your screen, avoiding unnecessary wear, and 
it's secure, keeping your work away from prying eyes. You can use the screen saver 
that comes in Windows 3.1 (it's found in the Control Panel Desktop) or any of the 
many commercial products, such as AfterDark or Intermission.

Extra Protection from Windows' Screen Saver If your workspace is 
chaotic, Windows 3.1's screen saver password feature offers more than 
confidentiality: It can prevent unintended text entries when, for example, a hefty 
report plops onto your keyboard, pressing some of the keys. From the Control Panel 
Desktop dialog box, click the Setup command button in the Screen Saver section. 
Turn on the Password Protected option and use the Set Password command button to 
set a simple, unforgettable password, like the first letter of your name.

Then exit and restart Windows. When a keystroke or mouse movement 
interrupts the screen saver, the password alert box prevents random keystrokes from 
affecting your program until the correct password has been entered.

A Screen Saver with a Personal Touch One of the several screen-saving 
patterns that comes with Windows 3.1 is called Marquee. By default, it displays the 
words "Windows 3.1," but you can customize the message, the background color, and
the font of Marquee, so there's no excuse not to really personalize Windows. You 
might want to tell people where you've gone, when you'll be back, or maybe you just 
need a little push to get yourself back to work. How can you possibly sit there 
wasting time when your screen saver scrolls the message "Why Aren't You Working 
on the Anderson Proposal?!" in 50-point black type across your bright red screen 
every few seconds?

Screen Captures
Once you've got your desktop truly customized, why not capture it so that others can
see just how great Windows can look. Use the Clipboard to take a screen capture of 
your Windows desktop that you can save as a graphic file or printout. Arrange 
everything the way you want it to look, and then, depending on your keyboard, press 
a keyboard combination that involves the Print Screen key. For some keyboards, you 
need to press the Print Screen key once; others require that you press it twice; still 
others require that you to hold down the Shift key while pressing the Print Screen key.
You should be able to tell when the screen has been captured by watching the arrow 
of your mouse pointer. The arrow will momentarily disappear and then reappear, 
almost as if a photograph were being taken.

You can verify that your screen has been captured by opening the Clipboard. A
copy of your desktop should be inside it. You can then save the capture as a 



Clipboard file, or open Paintbrush and select Paste from the Edit menu. A picture of 
your desktop will appear, ready for you save as a .BMP, .PCX or .TK file. Or you can 
personalize it even further by using some of Paintbrush's drawing and paint tools.

If you notice that only part of the desktop appears when you choose Paste, try
pressing Ctrl+O (Zoom) before selecting the Paste command. You'll see a grid-like 
representation of a full screen. Press Esc and a regular picture of your desktop 
(zoomed out) will be visible.


